OLIGO Primer Analysis Software Version 7
Assembled in 2009 by Wojciech Rychlik
Molecular Biology Insights, Inc., Cascade, CO, USA
http://www.oligo.net/

2	
   	
  

OLIGO 7 Tutorial & Examples
Table of Contents
1. Oligo 7 Installation
1.1. Installation
1.2. Registration
2. File Opening and Viewing
2.1. Open a sequence file
2.2. Open a database file
3. Navigating in OLIGO
3.1. Moving around a sequence file
3.2. Changing windows appearance
3.3. Open and Print all relevant windows with one mouse click
4. Search for Primers and Probes
4.1. Searching for PCR primers, a simple search
4.2. Searching for PCR primers, an example to show the options
4.3. Searching for sequencing primers
4.4. Searching for consensus hybridization probes
4.5. Searching for TaqMan Probes & PCR Pairs
4.6. Searching for Molecular Beacons & PCR Pairs
4.7. Searching for siRNA Probes
4.8. Searching multiple files (batch processing)
4.9. Searching multiple files for PCR primer pairs and than multiplexing the
selected sets
4.10. Searching a file for probes only in the selected regions
5. Other Search Options
5.1. Search for a sequence string
5.2. Search for restriction enzyme sites
5.3. Search for restriction enzyme sites in protein

	
  

3	
  

1. Oligo 7 Installation
1.1. Installation
Oligo software can be installed only if you have administrator privilages for this
particular computer. If you cannot save files to the Program Files or Applications
Folder you need to log out and log-in with the account that has administrator
privileages or ask your IT manager to install Oligo for you.

1.1.1. Installation form the Internet
Download the zipped Oligo package, Oligo7Mac_Installer.zip (Macintosh), or
Oligo7Win_Installer.zip (Windows) to your hard drive. Some systems unpack the
files automatically, and some require manual unzipping. Double click on the zip
file to unpack the contents.
Double click on the Oligo7Mac_Setup installer package (Mac; sometimes you
see the ".pkg" at the end of the name), or on the Oligo7Win_Setup (PC;
sometimes you see the ".exe" at the end of the name) to start the installation
process, and follow the on-screen instructions. In Macintosh, Oligo is installed in
Oligo sub-folder in the Applications folder. In PC, the default folder is C:\Program
Files\Oligo 7. Start Oligo 7, fill out the registration form and register it, as
described in Chapter 1.2.

1.1.2. Installing OLIGO from a Compact Disk
To load the OLIGO program to your hard drive:
1. Insert the Oligo 7 Disk into computer's CD drive.
2. Mac: double click on Oligo7Mac_Setup.pkg installer package, and follow the
instructions displayed on screen.
PC: Double click on the Oligo7Win_Setup.exe icon displayed in the CD
drive window. Follow the on screen instructions. You would be asked for the
folder name and location of the Oligo 7 application.
3. Once the installation is complete, double click on the Oligo 7 icon to start it
and register your program license. Alternatively you can start Oligo by
choosing "Start" from the desktop, followed by "Programs".

1.2. Registration
In order to protect your copy of the OLIGO program and provide you with prompt
technical support, we need you to register as an OLIGO user with your distributor
prior to accessing OLIGO or seeking technical support.
The registration form takes a few minutes to complete and you should receive
your access code within an hour after contacting your distributor during normal
business hours.
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Each installation creates a unique workstation code, so you will need to register
each computer separately.
To register your OLIGO software on a computer, please follow these steps:
1. Double-click on the OLIGO icon to call up the registration procedures.
2. Once the "Customer Registration" window appears, complete each field.
Use either the mouse or <Tab> to move to each field. This window must be
completed for each workstation you are registering (See the figure below)
Your e-mail address must be entered to make the “Register” button active.
The Fax number should be entered only to get the “Print” button active.
Leave the Access Code field blank.

	
  
The OLIGO Customer Registration window.

Note: Your software license number is on the OLIGO CD, User Manual or/and in the email conformation of the purchase.

3. When you enter the license number the “Register” button should become
active, as shown below.
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If youʼre connected to the the Internet, click the “Register” button at this point.
The registration e-mail will be sent to MBI automatically, and upon its
completion the window should display the message “Registration form
successfully sent”. If you perform the registration during the MBI's normal
operation hours (Monday through Friday, h: 8-16, Mountain Time), expect
the returning Access Code within an hour. Otherwise, you may Exit the
Oligo and start it again at later time, when youʼd receive the Access Code.
Click the “OK” button to exit.
3a. If your network does not permit Oligo to send e-mails to us, press the Save
button, and this saved text file attach to your e-mail and send it to
mbisupport@oligo.net. No screen shots, please.
3b. If your computer is not connected to the Internet, please print out the
Registration Form by clicking the Print button, and fax it to MBI:
+1 719 684 7989.
4. When you receive the Access Code from MBI, go back to the registration
window by bringing it to the front or by re-starting Oligo, enter it to the
“Access Code” box, and click the “Confirm Code” button. The registration
process is complete.
To register your second and following computers, you need to complete the
same registration process each time. Any further updates are automatic but may
be also performed by using Oligo's Help menu.
Note: If you ever need to re-load OLIGO, write this message to the Comments field.
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2. File Opening and Viewing
The tutorials in this section give you an opportunity to learn how the features of
the OLIGO software can assist you in your research. Some of the tutorial
examples are intended to provide a general guide from which you can construct
your specific application. Others are specific, so that you can duplicate, if you
wish, similar results (similar, not exact, because future revisions of the software
may be slightly different in default parameters).
Note: if you want to duplicate the results in the search examples, open Human
eIF-4E.seq for your sequence file. It is located in the Oligo 7 folder i Test
sequences subfolder. Oligo example database is in Oligo 7 folder (universal
primers.odb).

2.1. Open a sequence file
Oligo opens variety of file types, such as DNA, RNA, protein sequences and
databases.
1. Choose File - Open from the File menu.
2. Navigate to the "Test sequences" folder by clicking at the bar displayed at the top of the
window.
3. At he bottom of this window you may choose a file format available to you. The default is
"Nucleic Acid", so that the DNA and RNA sequence files can be opened instantly by clicking
on the "Open" button. However, when you click on the "Nucleic Acid" pull down menu, you
would get this:

and you would be able to choose any of the three types of files. If youʼd choose "All Files"
Oligo would show a slightly different window (shown below) from which youʼd need to
choose the kind of file with “Open As” pull down menu.
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4. By choosing Format "Protein" and than choosing "Human eIF-4E.ami" you would open this
protein file and automatically reverse-translate it to DNA. The default reverse translation
method is Lathe (choosing most probable codons for human proteins), but if before opening
a protein file you would "Change - Rev. Translate Method" to "Degenerate", you would end
up with an entirely different DNA sequence - this time a degenerate one. Please try it.
5. When you open a protein sequence file in a degenerate mode, you'll see lots of degenerate
nucleotide symbols in the Sequence window, but the translation will not look exactly like the
original amino acid file because some degenerate symbols would cover more than one
amino acid kind. Instead of arginine symbol, "R", for example, you will get low case "r"
indicating that arginine is most likely, but also that some other amino acid ma exist at certain
position.
6. Choose "Melting Temperature Graph" from the Analyze menu.
7. Click at the "graph" (

) button and choose "Degeneracy". You should get this window:

8. At this point the scale displays degeneracy. Those numbers are usually high for a default
size of Current Oligo of 21 bases. To get more manageable degeneracy change the Current
Oligo length, using the Change menu, to 17. At this time you should be able to find oligos
with relatively low degeneracy.
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9. Click on the Analyze menu. Note that in place of former "Melting Temperature Graph" item
you'd find "Degeneracy Graph". You may change the display back to tm analogously as
described in point 7.

2.2. Open a database file.
1. Choose File - Open from the File menu.
2. Choose "Oligonucleotide Database" as File Format.
3. The "Test sequences" folder doesn't have any database files, so all the files are greyed-out.
Go up one folder higher by choosing Oligo 7 folder form the top menu.
4. Open "universal primers.odb". You should see the database window:

5. Click on record #3. From the table you can read that it forms a 3'-dimer of 4 kcal/mole, and
that this value is above the parameters threshold (to change the thresholds you'd have to
use "Options" button).
6. To see the actual dimer go to the Analyze menu (database has a different Analyze menu)
and choose "Duplex Formation". When you check this window you may close it.
7. The database has a powerful multiplexing option. Click on "Analyze - Multiplex All Oligonucleotides - Minimize Reaction #". Oligo automatically finds compatible oligo sets
among the entries labeled "SC", that stands for Self-Compatible. You may view those sets
by clicking on the triangles located at the lower right:

The example above shows Group 1, consisting of oligos # 2,6,9, and 10 in the database. All
those four oligos do not form 3'-end dimers among themselves within currently set search
parameters in the Database Options.
Note: if your database contains probes instead of primers, you need to change the
multiplexing mode from checking for 3'-dimers to checking homology (or rather inverse
homology) to find out what probes stick to each other. In this case, use the Change menu,
and choose "Multiplexing Mode -> Probes: check homology":

8. Let's make a new set of primers in the database. From the Edit menu choose "Add Set".
The lower part of the window changes and shows four edit boxes, under "Enter Record #'s".
9. Enter to the Forward Primer box "9" and to Reverse enter "10". The "Add" button activates.
10 Click the "Add" button, followed by "Show All" button.
11. You should see a new row added to the database. If the window is not tall enough, use the
slider (a dot separating individual oligo entries from sets), and drag it up.
12. Close the Database window without saving.
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3. Navigating in Oligo
Note: if you want to duplicate the results in the search examples, open Human
eIF-4E.seq for your sequence file.

3.1. Moving around a sequence file.
After the registration, described in the User Manual, Chapter 2.3, you may open
a sequence file or a database. This example describes how to move around and
what features are immediately available to you after opening a sequence file.
1. Open a sequence file: use File-Open, and in the "Test sequences" Folder choose Human
eIF-4E.seq. Click on the "CDS" row displayed at the top right of the window. You should
see the Sequence window, as depicted on the figure below:

2.

3.

4.

5.
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Clicking on "CDS" highlighted the coding region of eIF-4E DNA sequence (it is actually the
mRNA sequence reverse transcribed to DNA)
Move the horizontal bar. You will notice that the yellow-shaded box moves around the Tm
graph. Sequence in this box is displayed at the bottom of this window. Click on any
nucleotide displayed this window - you just changed the Current Oligo position. All the
features of the Sequence window are described in the Manual, Chapter 2.5. You may move
down or up the sequence using the keyboard (arrows, page up or down).
Keep the Sequence window opened, and choose "Open Reading Frames" from the Analyze
menu. If you click on any nucleotide position you also change the Current Oligo position:
observe the Sequence window while playing with the ORF window. You may change the
reading frame just by clicking on the open reading frames displayed in the top portion of the
ORF window.
Close the ORF window (for clarity) and open the Melting Temperature Graph and/or Internal
Stability - Current Oligo windows from the Analyze menu. Note that by clicking on the
nucleotide symbols or the graph itself you are actually moving to the new positions. If you
zoom out the Tm window, by clicking on the loupe symbol with "-" sign, you still can change
the Current Oligo position by clicking on the graph.
Close all but the Sequence window and choose "Selected Bases" from the Search menu.
You will see 4 columns there. "Loops" (showing strong stems of the sequence) and
"Strings" columns are empty, because you haven't searched yet for the strings, and there
are no strong stems (below -12 kcal/mol: a default search parameter setting for "Template

Loop ΔG Threshold" with the "Template Loop Window Size" of 40 nt.) in this DNA sequence
file. Columns (Hairpin loop) "Stems" and "Palindromes" are filled with numbers, as those
searches are initiated automatically as soon as you open a sequence file. By clicking on any
of those numbers you change the Current Oligo position.
6. Another method to change the Current Oligo position is to open the "Select New Current
Oligo Position" from the Select menu and entering the desired position number.
7. Make a quick search for Sequencing Primers (Search -> for Primers & Probes...-> click
"Sequencing Primers" followed by "Search" buttons). After the search you'll see the Analyze
-> Selected Oligonucleotides window. You may also select the Current Oligo by clicking on
any row displaying Forward or Reverse Primers. By double clicking on these primers in the
Selected Oligonucleotides window you will not only change the Current Oligo position, but
also you will select the actual primer (observe the Sequence window how it changes).

3.2. Changing windows appearance
The display of certain windows can be customized. The Edit windows, for
example have two display modes, as well as all the Analyze windows with the
"Options"

button.

1. Open the Edit - Entire Sequence window. You should get the "Full Screen Edit" window.
2. This window has its own menu. Click on Edit item. You should see the following menu:

3. Note a dot by the "Full Screen Edit". It indicates the current window style.
4. Click on the "Mutagenesis" item. The window changes its appearance (see the following
figure). If you'd be editing a primer, this type of window would open automatically.
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5. Close the Edit window and open the Melting Temperature window.
6. Click on the "Options" button. You should see this:

7. Click on the "Bars". Now the Tms of the oligos is displayed as bars instead of dots. This
type of change is available on Internal Stability and Sequence Frequency windows as well.
8. Click on the small graph icon (

). You should see this menu:

At this point you may choose a different kind of Current Oligos representation. The default
was "tm", showing melting temperature graph of oligos without dangling ends. Tm(+) shows
the same but with the dangling ends, and Tm(-) shows Tm with dangling ends of oligo
complements. Similarly, "ΔG(+)" and "ΔG(-)" shows free energy graph with dangling ends of
Current Oligos and their complements, respectively, while "Δg" represents the standard
values, without the dangling ends. "CG%" shows the CG content, and Degeneracy (active
when the sequence is degenerate) shows the number of possible sequence combinations.
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9. Close the Melting Temperature window and open the Open Reading Frames window. When
you click the "Options" button, you'll be able to change

the meaning of open reading frames color coding from amino acid type to codon frequency.
10. Note a slide button at the top left of the ORF window:
By dragging it to the right you'll see zooming in the ORF graph. This feature is very useful
when the opened sequence is large.

3.3. Open and Print all relevant windows with one mouse click
You can open or print all the windows of your choice with just a one click. To set
this up you need to:
1. Open the File – Print/Save Options window. The default is to print or save only the top
(current) window, as shown below.

2. Click the “Selected” button, and than check the appropriate boxes. In this example, we
check the Key Info for the Forward and Reverse primers and Duplex Formation windows for
the Forward, Reverse and mixed primers, and also weʼve changed a different database print
output to Full Analysis and the Multiplexing data, as shown below.

3. Click the OK button. From now on, the short cut key Ctrl-X (Windows) or Command-X (Mac)
is activated (see the last item of the Analyze menu), so with this keystroke you will open all
the windows that youʼve checked, of course if youʼve previously selected the primers.
Saving Results will also save multiple windows data.
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4. Search for Primers and Probes
This section describes methods in searching primers and probes, the "Search for Primers & Probes..." menu item.

Take a quick look at the Search for Primers dialog window. At the top you see
two tabs, Search Options and Subsearches. Below this there are two check
boxes - if both checked the search will proceed in both DNA strands. The
Search Mode is set to "Select", that is, the search will start from scratch, and not
continue on already selected primers (that's the "Verify" mode). If you uncheck
the "Complex Substrate" box, good when working with plasmids, not with total
organism DNA, a sub-search to eliminate frequent oligos will not take place.
Below this box, you see a list of possible search types that Oligo can perform.
Buttons on the right: the "Search" button starts the actual search, "Cancel" closes
the window, and "Apply" memorizes the current type of search, so that when you
"Cancel" the window and come back to it you'd see the most recent setting.
"Apply" also sets the search parameters and accordingly, modifies the Sequence
and other relevant windows. Button "Parameters" opens the search parameters
windows, including windows that define the stringencies and scoring system.
Button "Ranges" opens a complex dialog that controls not only the search
ranges, but the number of results you need within the ranges. Button "Defaults"
changes all parameters to the default values. This chapter will guide you through
various search types.
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4.1. Searching for PCR primers, a simple search
This example takes you through a quick search for a pair of optimal PCR
primers. To run this search, open Human eIF-4E.seq file and:
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked.
3. Click "Search" to start the search. The "Search Status" progress window appears, and the
message "Search Completed" appears when the search is complete.
4. When the search is complete, two windows open: "Oligonucleotide Sets" and "Selected
Oligonucleotides". You may also check the "Primers & Probes Search Data" (from the
Search menu) window to make sure that the final search stringency is acceptable. OLIGO
automatically reduces search stringency if it does not find any compatible pairs.
5. There are six sort options on the "Oligonucleotide Sets" and "Selected Oligonucleotides"
windows. The sort order is indicated in the figure below by red arrows:

You may change the sort order by simply clicking at the column name. Option-click (or Altclick) allows for multiple sorts. You may also sort the data by product length or any other
field not sorted in the example above.
9. Click on a primer pair to select this primer pair or double click on a pair to view the "PCR"
window for the selected pair.
10. Choose the primers from the Analyze - Key Info menu or other Analyze menu windows to
view the primer sequence and/or related data.

4.2. Searching for PCR primers, an example to show the options
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked.
3. Click the "Parameters" button. At this point you see the General Parameters, as indicated at
the top of the window:

This will let you change the search stringency globally, change sequence frequency table
and salt and primers concentration in the reaction mix. By default, the stringency search is
set to "High". If you experience a long search time, you may shorten the search by starting
from a lower stringency type. Otherwise, Oligo will reduce the stringency automatically if
needed, as long as the "Automatically change stringency" box is checked:

4. Choose the "Fair" search stringency.
5. Check the "Constraints" and "More Constraints" options. Each sub-search option that will be
active for a given search method has a blue dot on the left. The irrelevant sub-searches
have no blue dots. To the right of this dot you should see an open or closed lock. This
represents whether a given parameter can be changed during automatic stringency search.
You may wish to permanently fix a specific parameter to the displayed value by clicking on
an open lock. The lock should close. Some parameters Oligo is not able to change
automatically. These sub-searches are labeled with grey-out locks. The image below
shows one of the sub-searches in the "More Constraints" window
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This is active parameter for Compatible Pairs search (blue dot on the left) and the automatic
stringency may change it, if necessary. For sake of this example, increase this value to -6
kcal/mol and lock this value, and click "OK". You've just set the parameter of a sub-search
that will eliminate all the PCR products (not the primers!) that would make a hairpin with a
ΔG larger than -6 kcal/mol, with the size of this hairpin not larger than 40 nt. (if the "Template
Loop Window Size" was set to 40 nt). Note that this test sequence has only one loop like
this around pos. 160-200 (Sequence window marks it in maroon color).
6. Click the "Ranges" button. Instead choosing the search ranges manually, click the "Check
Region(s)" button.
7. From the "Features" window select the #2: CDS (coding sequence), so you should see this:

and click the "Accept" button.
8. Check the "Find products in checked region(s) only" box.
9. Check also the box "No multiple products in one sequence region" and "Cover the entire
search area with" "Overlapping products".
10. Change the PCR product length to "150 to 300".
11. Click the "OK" button. You should get just the coding region covered with PCR products,
and the hairpin loop in the template gone from any PCR products.

4.3. Searching for sequencing primers
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Click on "Sequencing Primers" button
3. Choose the DNA strand the primers should be made of: leave checked "Search in: + Strand"
if you want primers to sequence forward (they would be annealing to the negative strand),
and uncheck the "- Strand".
4. Choose the region you want the primers located: click the "Ranges" button and type
"Positive strand search range:" 400 to 450. The negative strand search range is irrelevant.
5. Make sure the "No overlapping primers/probes" box is checked if you want to avoid multiple
choices of almost identical primers.
6. Click "OK" button.
7. Click the "Search" button. You should get only one primer in the "Selected Oligonucleotides"
window.
8. Double click on this primer in the "Selected Oligonucleotides" window. You've just selected
a sequencing primer.

4.4. Searching for consensus hybridization probes
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Click on the "Hybridization Probes" button
3. Click on the "Subsearches" tab at the top of the window.
4. Click on the "Consensus Probes" box at the bottom of the window. A new window "Select
Files" pops out, and you need to select other homologous sequences.
5. Click the "Add" button and navigate to the Test sequences folder, supplied with the software
(by default it is located in the Oligo 7 folder in the Applications folder).
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6. Choose the files as shown on the image below:

by repetitively clicking on a file name and the "Add" button.
7. Click the "Done" button and return to the "Select Files" window. The window should look
similar to the one depicted above.
8. You may click "OK" now, but if you'd like to memorize this set so that you can use it at later
time, click the "Save Set" button and give it a descriptive but short name, than click "OK".
9. Go back to the "Search for Primers & Probes", and click the "Search button".
10. The results are displayed in the "Selected Oligonucleotides" window. Sort it by "Oligo
Position" by clicking on the "Oligo Position" title.
11. Double click on the second oligo (pos. 57). You've just selected a non-degenerate probe.
You may check it on any relevant Analyze windows. In the top right of the Selected
Oligonucleotides window there is a check box "Select consensus oligos". If it's checked, the
selected probe would contain a few degenerate bases. This is because it is a consensus
probe. You may check the alignment by dragging up the dot located at the bottom center of
the "Selected Oligonucleotides" window, see below:

Note that the mismatches with the File 1 (the principal sequence) are marked in red.
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4.5. Searching for TaqMan Probes & PCR Pairs
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Click the " TaqMan Probes & PCR Pairs" button.
3. Click the "Search" button. The sets are found and displayed in the "Oligonucleotide Sets"
Table.
4. Click once on a set to select it, or click twice to choose it and open the PCR analysis window
at the same time.
5. If you don't like the default Tm difference between the primers & the probe, before the
search you may alter it by changing the "Tm of Probe - Tm of Primer" search parameter in
the "Constraints" window.
6. If you need only a specific DNA region to work with, before the search you may set the
search range by choosing it from the "Search Ranges" window (click the "Ranges" button
and enter the positive and negative strand search range in the top of the window, following
by the "OK" button).

4.6. Searching for Molecular Beacons & PCR Pairs
1. Choose the "Primers and Probes" option from the "Search" menu.
2. Click the " Molecular Beacons & PCR Pairs" button.
3. Click the "Search" button. The sets are found and displayed in the "Oligonucleotide Sets"
Table.
4. Double click on a set to select it and open the PCR analysis window at the same time. Note
that you get a seemingly disturbing comments "The Upper Oligo does not match the
template" and "3'-end Upper Oligo dimer". This is a sign that the beacon probe was
selected successfully.
5. To see the alignment with the template choose the Sequence window and move the
horizontal scroll bar to see the probe:

6. View the probe under various Analyze windows, especially Analyze - Hairpin Formation Upper Oligo.
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4.7. Searching for siRNA Probes
1.
2.
3.
4.
5.

Open Human eIF-4E.seq.
Choose "DNA to RNA" from the "Change" menu.
Choose the "Primers and Probes" option from the "Search" menu.
Click the " siRNA Probes" button.
Click the "Search" button. The oligos are found and displayed in the "Selected
Oligonucleotides" Table.
Double click on the first record. You've selected the sense strand of a siRNA probe.
Choose "Lower Oligos" from the pull down menu (top left of the window).
Double click on the first record. You've selected the antisense strand of a siRNA probe.
Check the Internal Stability window ("Analyze"- "Internal Stability" - "Lower Oligo"). It should
like similar to this one:

7.
6.
7.
8.

The negative strand probe (always a 19-mer) should start from a pentamer of -7.5 kcal/mol
or so, its 3'-end should be slightly more stable than 5'-end, the internal 12-mer stability
should be about -22 kcal/mol, should not form significant internal hairpin loops, should not
have sequence repeats, and should be as unique as standard hybridization probes.
9. Add manually TT or attach dinucleotides corresponding to the original mRNA to the 3'-ends
of the oligos: use "Edit" - "Upper (Lower) Oligo" options. The dTdT is preferred for a better
probe stability.

4.8. Searching multiple files (batch processing)
1.
2.
3.
4.
5.
6.

Start Oligo and choose "Search" - "Sequence files".
Select files: choose the entire Test sequences folder.
Choose the Method of search: Hybridization Probes.
Click the "Ranges" button and check the "Choose hybridization probes every" "1000 bp".
Click "OK", and another "OK" to get back to the "Batch Processing" window.
Click the "Search" button. Before Oligo starts searching it asks you for a file name for the
results data. Default is "BatchResults.txt", a plain text file. Enter a new name or leave it as
is. Note that you may save the file in three different formats: Simple List, Full Analysis or
Oligonucleotide Database. Accept the name by clicking at the 'Save" button.
7. The Search Progress window displays how many files were processed and scheduled. The
search ends when this progress window disappears. Open the BatchResults.txt file with any
word processor.
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4.9. Searching multiple files for PCR primer pairs and than
multiplexing the selected sets
1.
2.
3.
4.

5.
6.
7.

7.

8.

Start Oligo and choose "Search" - "Sequence files".
Select files: click the "Select Files" and than "Add" in the Select Files window.
Make sure the File Format is set to "Nucleic Acid", and choose the Test sequences folder.
Select three files: Human, Mouse and Rabbit eIF-4E.seq and click "Add", and than “Done”
button. Clicking “OK” button will accept the selected files, but before clicking OK you may
want to save the set of files for later use with the "Save Set" button.
In the "Batch Processing" window set "Save 3 results per file" and click the "Method" button.
Choose "PCR Primers " option and click the "OK" button.
Click the "Search" button. Before Oligo starts searching it asks you for a file name for the
results data. Default is "BatchResults.txt", a plain text file (Simple List). You'd need to save
this file in Oligo database format, so change the File Format (low portion of the window) into
"Oligonucleotide Database". Enter a new file name on the top or leave it as is. Note the
destination folder, and if it is not correct, change it. Accept the name by clicking at the
"Save" button.
The Search Progress window displays how many files were processed and scheduled. The
search ends when this progress window disappears. Open the BatchResults.odb file with
Oligo.
The database window should look like this:

On the top you'd see the individual primers and on the bottom the sets. You may sort data
of any of the columns by clicking on the column title (secondary sort when holding the option
or Alt key pressed). This applies also for the Sets portion of the window. Product length is
calculated from the ID Number description, so if you make a set manually the product length
may be incorrect or not show at all.
9. From the Analyze menu choose Multiplex All - Sets - Minimize Reaction #. The bottom of the
window shows the compatible sets of primers,
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where the set numbers are marked in red, and in parenthesis you see the individual primer
numbers. Depending on the Database Options the results may vary. You may change the
Group display by clicking on the slider, and when you click the "Select" button all the primers
in a displayed Group get highlighted.
10. You may select those primers by clicking on the check boxes individually on the left of the
window or check all selected primers from the Export menu. Checking may be important for
saving or printing data, depending on how is the priting set from the Print/Save option in the
File menu. The Show/Hide icon (to the left of the checkbox icon)

may be used to show either the first highlighted record, oligonucleotide sets or multiplexing
results. Hide option conceals the bottom part of the Database window.

4.10. Searching a file for probes only in the selected regions
1. Start Oligo and open BRCA2 gene.seq located in the Test sequences folder.
2. Open "Search for Primers & Probes" dialog window and choose "Hybridization Probes".
3. Make sure that the “Parameters” Search stringency is set to “Moderate” (it actually may be
anything, but the window snap shots here would be when the Moderate stringency is used.)
4. Click the “Ranges” button and click the Check Region(s) button at the lower left.
5. When you open the Features window, check the third check box from the top as shown
below:

This selects all the mRNA regions in the gene.
5a. Note: you may create a new feature, for example, if you want probes in the end and the
beginning of the sequence only you may click the “+” button at the low left of the window and
type name of the featue (such as “ends”), double click in the “Location” column, and type
“join(1..1000, 84468..85469)”, and click on the check box.
6. When the Feature #3 is highlighted, the bottom of the window shows a map of the regions
where the search will be performed. Click the Accept button, returning to the “Search
Ranges” window. Note: not only when you enter a new feature but even if you check another
feature you myst click the the Accept button. Later on Oligo will ask you to save the
sequence to make this change permanent.
7. Check the “Find oligos in checked region(s) only, as shown:

	
  

21	
  

Note that another option to search in discontinuous regions could be “Choose hybridization
probes every x number bases”.
8. Click “OK”, and in the “Search for Primers & Probes” window click the “Search” button.
9. The search returned 151 Upper Oligos and 148 Lower Oligos located only in the mRNA
regions.

5. Other Search Options
5.1. Search for a sequence string
Oligo's search for string is not just a plain 'Find' function commonly implemented
in most editing software. It allows searching for mismatches and for ambiguous
bases. This example shows the process.
1. Start Oligo, open Human eIF-4E.seq and choose "Search" - "for a Sequence String +
strand".
2. Type a degenerate sequence CAYNNNNRTG. It's an Msl I recognition site and click the
"Find" button.
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3. The results pop up in the "Selected Bases" window in the "Strings" column. Click the last
position (1813). You should see the following window:

The pos. 1813 is highlighted. At the same time the Current Oligo pos. 1813 is selected and you
can see this in the Sequence window:

The arrows point to pos. 1813, marked in orange. This position is at the beginning of a 10 bplong palindrome (marked in green). The palindrome itself was selected as the Upper Oligo,
shown above as the top sequence in red.

5.2. Search for restriction enzyme sites
1.
2.
3.
4.
5.

Start Oligo, open Human eIF-4E.seq and choose "Search" - "for Restriction Sites..." option.
Click the "Select Enzyme Database". The files are located in the Tables sub-folder.
Click the 5&UP.ENZ file containing most 5-cutters and higher and the "Select" button.
Choose "Linear" sequence and click the "Search" button.
You should see the results in the "Restriction Enzyme Sites" Analyze window:
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This window consists of two parts. The top one is a graphical representation: the entire row
represents the length of the sequence file and the blue vertical lines are the recognition
sites. The bottom part is the enzyme listing, ended at the bottom with a list of non-cutting
enzymes (scroll the bar down to see it: the picture above does not show it). The actual
recognition sites are listed in black, and the fragment sizes are in green.

5.3. Search for restriction enzyme sites in protein
This search reverse-translates a protein sequence into all combinations of
reading frames and finds all possible restriction enzyme sites that could be
made. This feature is useful in gene construction projects. The example below
shows how to find a protein of interest, set the proper reading frame and then
find the restriction sites only in this protein.
1. Start Oligo, open BRCA gene.seq and open the Open Reading Frames window from the
Analyze menu.
2. Find the longest pen reading frame in the sequence. This is the one we'd like to analyze for
potential restriction enzyme sites. Click on the graphical representation of it to set the proper
reading frame (see the graph below). You may use the zoom-in slider located at the top left
of the window for a better view.
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3. Choose "Search" - "for Restriction Sites in Protein..." option. It should indicate Reading
Frame 2.

4. Type in the Start and End position numbers of the protein. You should find those numbers in
the ORF window.
5. Click the "Search" button, if you want to find all possible enzyme "Cut Types".

6. After the search the results are displayed in a window with a very similar format to the
standard "Search for restriction enzyme sites" window, except that the degenerate protein
site is listed instead of the actual DNA recognition site sequence (all those symbols are
explained in the Appendix E of the User Manual).
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